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6 

Chapter 1: Introductiion to M.S Excel 

Introduction to MS Excel 
 
Microsoft Office Excel is a powerful spreadsheet tool used to organize, manipulate and 

analyze data. Spreadsheets are commonly be used to perform many different types of 

calculations. Excel is often used in the workplace to track statistics, create sales reports, 

financial modelling, scientific engineering, and making charts and graphics. 

 

 

THE EXCEL WINDOW 
 
 
When you first open up Excel, a new file is created named as Book1 by default (you can 

rename it later). It is named as “Book” because it is a workbook made up of three 

worksheets (each worksheet can be accessed from tabs in the lower left corner of the 

excel window) 
 
 
The Excel Workbook window is the area where the data are stored and manipulated. 

This window is divided into rows and columns. Rows travel horizontally and are 

numbered. Columns travel vertically and are assigned alphabets. 
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Cell The intersection of a row and column is called a cell. Cells are the basic 

rectangular building blocks of a spreadsheet. Each Cell is assigned with cell 
address. Cell Address/Cell Reference begins with Column Name followed by Row 

Number (e.g. Cell Address is C9, having column name C and row number 9). Each cell is 

made up of inbuilt calculator. 

 

Title Bar Displays the name of the current workbook and it holds some control 

buttons to Minimise, Restore & Close the Excel Window. 

Quick Access Toolbar Found next to the office button in the Title Bar 

provides quick access to commonly used buttons. The default buttons are 

Save, Undo and Redo, It can also be customized. 

 

Ribbon/Menu Bar Menu Bar consist of Menus such as File, Edit, View, 

Insert, Format, Tools, Data, Window and Help. In Excel 2007 the Drop-

down Menu Bar is replaced by Tabs with Horizontal Ribbon such as Home, 

Insert, Page Layout, Formulas, Data, Review and View Tab. Within each tab, 

various related options may be grouped together for easy identification. 

The Ribbon is designed to make the features of the application more 

discoverable and accessible with fewer mouse clicks. 

 

Formula Bar Displays the contents of the active cell. This could be a 

formula, data or just text. Formula always begins with = (equal to) 

otherwise Value is a Text or Constant. The Cell which contains formula will 

display only the end result of the formula where as Formula will be 

displayed in the Formula Bar. 

 

Active Cell The cell you are currently working with is active cell. Thick 

Bordered Black outline surrounding the cell indicated the current active 

cell. To change which cell is the active cell, simply click on it or move to it 

using the arrow keys on your keyboard. 

 

Name Box Displays the active cell address or the name of the selected cell/ 

range. Cells are named by giving the column letter and then the row 

number. For example, B3 means the active cell is located in column B and is 

in the 3rd row. 
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Chapter 2: Data Entry & Fill Series 

DATA ENTRY IN EXCEL 
 

Entering repetitive data into a spreadsheet can be time-consuming, and 

mistakes will often find their way in — with Excel’s simple built-in data entry 

tools you can improve both speed and accuracy. 

 

The standard setup in Excel is to press TAB to move your active cell to the 
right by one cell, and press ENTER to move your active cell down by one cell. 
 

Simply use SHIFT + TAB to the previous cell on the same line. And you can use 
SHIFT + ENTER to go one cell up. 

 

How to configure Excel’s default cell movement 
 
In Excel 2007 / 2010 you need to first choose OPTIONS from the OFFICE  
BUTTON or FILE menu. Then, click the ADVANCED menu and do one of these 

things: 

 

1. Check the ―After pressing Enter, move selection‖ check box and select 

the direction you want (Down / Right / Up / Left)  

 
2. Clear the ―After pressing Enter, move selection‖ check box to inhibit 

any movement when pressing Enter.  
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3 ways to edit a Cell: First activate the cell to be edited. Then go for any of these options 

 

 Option1: Press F2 
 Option2: Double click the cell 
 Option3: Edit in the Formula Bar 





FILL SERIES IN EXCEL 
 
 

Instead of entering data manually on a worksheet, you can use the Auto Fill feature to 
fill cells with data that follows a pattern or that is based on data in other cells. 

 

Fill Handle is a small black dot or square in the bottom right corner of the Active Cell. 

The fill handle has a number of uses including copying a cell’s contents to adjacent cells 

or to create a series. Use the fill handle by clicking on it with the mouse pointer to drag 

& select adjacent cells. 

 

AutoFill using Fill Handle: It allows you to quickly fill data in a series into adjacent 
cells. (e.g. months, days of the week, or a numeric series) 

 


 

 Numeric Series: Auto fill can also be used to quickly enter numeric patterns 

(e.g. 1, 2, 3 or 10, 20, 30) into adjacent cells. To use Auto fill with numeric 

patterns, enter the first two values in the series, one value in one cell and the 

next in the cell immediately below or to the right. Now select both cells. Using Fill 
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Handle, Click and drag down or across the cells you want to fill, and then release 

the mouse button. 

 

                  
       (Method 1) 

 

 
(Method 2) 

 

 Text Series: Type the first word of the series (e.g. January) then using 
fill handle click and drag the series down or across the number of cells 
you would like to fill this series. 
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The series can also be customized, click Office Button ➪ Excel Options ➪

Popular 

Category ➪ Click Edit Custom Lists. When the Custom Lists window 

appears, select 
 
“New List” in the column on the left (it will probably already be selected) 

and type your whole list in the column on the right. You can also import a 

list you have already typed into cells by clicking on the import symbol, 

selecting the list you wish to import, and pressing “Enter.” Click “OK,” 
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CTRL + PAGE_DOWN Moves to NEXT SHEET in a Workbook 

CTRL + PAGE_UP Moves to PREVIOUS SHEET in a Workbook 

CTRL + ARROW_KEYS 
Jumps to the last populated cell in that direction, Moves to the end of the 
range 

CTRL + SHIFT + 
ARROW_KEYS 

Extends the selection of cells to the last nonblank cell in the same column or 
row from the active cell 

CTRL + D Fill Down command 

CTRL + R Fill Right command 

ALT + TAB Toggles/Switches between different/same applications 

CTRL + TAB Toggles/Switches between different/same applications 

ALT + F4 Closes all Opened Files 

CTRL + F4 Closes only Current File 
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Chapter 3: Inserting and Deleting Row/Column 

 

Column is always inserted to the left hand side of the selected cell. Row is 
inserted above the selected cell. 

 

4 WAYS TO INSERT ROWS/COLUMNS 
 

o Click the single Cell >> Right Click & choose INSERT >> In Insert Dialog 
Box, Select   
Entire Column/Entire Row >> Click OK   

o GoTo Cells Group from Home Tab >> Click down arrow from Insert 
Icon >> Select  

Insert Sheet Rows/ Insert Sheet Columns  
o Select the column Heading/Row Heading >> Right Click & choose 

INSERT (if column heading is selected Column is inserted, if row 
heading is selected Row is inserted)  

Shortcut Key 
 

 Select a Single Cell >> CTRL “+” (in PC), CTRL + SHIFT “+” (Laptop) >> From Insert 
Dialog Box, Press “C” to Insert Column & Press “R” to Insert Row. 



 Select Column/Row Heading >> CTRL “+” (in PC), CTRL + SHIFT “+” (Laptop) 


 

4 WAYS TO DELETE ROWS/COLUMNS 
 

o Click the single Cell >> Right Click & choose DELETE >> In Delete Dialog 
Box, Select   
Entire Column/Entire Row >> Click OK  

 
o GoTo Cells Group from Home Tab >> Click down arrow from Delete 

Icon >> Select   
Delete Sheet Rows/ Delete Sheet Columns  

 
o Select the column Heading/Row Heading >> Right Click & choose 

Delete (if column heading is selected Column is deleted, if row heading is 
selected Row is deleted)  

 
Shortcut Key  

 Select a Single Cell >> CTRL “- (minus)” >> From Delete Dialog Box, Press “C” to 




Delete Entire Column & Press “R” to Delete Entire Row. 


 Select Column/Row Heading >> CTRL “-(minus)” 
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INSERT ALTERNATE COLUMNS/ROWS 
 

Use CTRL Key and select multiple Columns/Rows one by one then Press 
CTRL + “Plus(+)”. It inserts columns next to each selected column. 
 

F4 – Repeats last action 
 

F4 can also be used to insert Alternate Columns/Rows after inserting a 
row/column 
 

Changing Cell Background, Text Color, Bold, Italic, Underline is encountered 

by excel as actions and these task can be repeated using shortcut key F4. 

Only the recent action will be repeated. To make all this into single action, 

Right Click & Choose Format Cells >> Now Change Cell 
 

Background, Text Color, Bold, Italic, Underline >> Click OK. Now use F4, 
which performs all the actions done in format cells dialog box into a single 
action. 
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Chapter 4: Cell References & Ranges 

CELL REFERENCES 
 

When we copy a reference from one cell to another, it gets updated 
automatically. 
 

 

Example: we have a reference in cell B2 as A2 and we copy the 
same to D2, it automatically updates itself to B2. 
 

Types of Cell Reference: 
 

There are three types of cell references as mentioned below; 
 

1. Relative cell references  
 

2. Absolute cell references  
 

3. Mixed cell references  
 

Relative Reference 

 

A relative reference will change column and row numbers as it is copied to 

other cells. When you fill formulae to another cell the row and column 

references will be updated to the corresponding row and column. By 

default, Excel creates relative cell references in formulas. 

 

If you drag the formula in Row, row reference will change. If you drag the 
formula in Column, Column reference will change. 
 

Example: F2=D2*E2 (D2 refers to the Column D & Row 2, E2 refers to 

Column E & Row 2). When this formula is copied in F5, Excel will have the 
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updated references to the current row number F5=D5*E5 
 

Absolute Reference 
 

When you want to freeze a cell reference or you want a reference to change 
when you copy a formula, you can use absolute cell references. To make a cell 
reference absolute, we place dollar ($) sign before the column name and row 
number of the reference. 
 

An absolute reference is one that does not change the cell references when 

copied to another cell. If you refer to a cell in a certain row and column and 

then copy that reference elsewhere, it will still refer to exactly the same cell 

or range. 
“$” symbol is use lock the cell reference. 
 
$A$1 Absolute column and Absolute Raw 

A$1 Relative Column and Relative Raw 

$A1 Absolute Column and Relative Raw 

A1 Relative Column and Relative Raw 

 

 

 

 

 

Mixed Cell references 

 

 
However at times you may want to freeze only the row or column in a cell reference. Example: 
$A1/A$1- Where both Absolute and Relative references are used. 

 
F4 is the Shortcut Key to introduce Dollar Sign ($) or to lock a cell reference. 

 

For example, if you enter =A1 to start a formula, pressing F4 converts the cell reference to =$A$1. 

Pressing F4 again converts it to =A$1. Pressing it again displays =$A1. Pressing it one more time 

returns to the original =A1. Keep pressing F4 until Excel displays the type of reference that you 

want. 

 

Magical Shortcut F4 
 

Outside Formula >> Repeats Last Action 
 

Inside Formula >> Introduces “$” sign (Absolute Reference) 
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FREQUENTLY USED EXCEL SHORTCUTS  
 F2 Edit Cell 
 F4 To lock the cell or Range 
 CTRL + D Fill Down 
 CTRL + R Fill Right 
 CTRL + SHIFT + Arrow Keys To select the Range or Table 
 CTRL + 1 Format cells 
 ALT + ENTER Move to the Next Line in the same cell 
 
 
 
 
 
 
RANGES 
 
Range: Selection of more than one cell/ group of cells is known as Range. 
 

Define Range: [Starting Cell Address: Ending Cell Address] or [Top Left 

Corner Cell Address: Bottom Right Corner Cell Address]. E.g. A1: B10 (A1-> 

Starting Cell Address, B10 -> Ending Cell Address) 

 

Note: If a range is very large you can find the Starting cell Address from the 
Name Box without scrolling the screen. 
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3 different methods to select range 
 

1. Using Mouse  
 

 Single Range: Click & Drag from the Starting Cell 
address to Ending cell Address 



 Multiple & Non-Adjacent Ranges: To Select 2nd, 3rd, 
4th…. range Press CTRL Key, then click & drag from 
the starting cell address to ending cell address for 
each range.  

2. Using Keyboard  
 Single Range: Use SHIFT Key + Arrow keys to select 

range. 

 Multiple & Non-Adjacent Ranges: Press SHIFT + 
F8, then use SHIFT + Arrow keys to select each 
non-adjacent range  

3.  Directly Enter Range Address in the Cell 

 

NAMED RANGES 
 
 

Many a times, when we write formulas/functions, we need to select a range 

of cells. However, doing this can be time consuming. Excel allows us to use 

a cell or a group of cells by its name. eg. Sum (Basic) sounds much easier 

compared to sum(H2:H101).However to do this, first we would need to 

name the range H2:H10 as Basic. 
 

 

Creating a Named Range 

 

2-ways you can create Named Ranges 

 

 Select the range and type the name in the Name Box. 


 Select a range >> Choose Formula Tab >> Under Defined Names >> 
Click Define Name >> New Name Dialog Box is opened >> Enter the 
Name you wish to give and Click OK 
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Now you may use the name instead of the range anywhere in the 
workbook. The named range can be used. 

 

  

To Edit/Delete Named Range 
 

Choose Formula Tab >> Under Defined Names >> Click Name 

Manager >> Name Manager Dialog Box is opened >> Select the Named 

Range and then Perform Either Edit/Delete as per your wish. 
 
Shortcut: Press Ctrl + F3 to get a Name Manager dialog box 
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Chapter 5: Working with Formulas & Functions 

 
FORMULAS 
 

Formula is a calculation that can be entered into any cell and consists of a 
series of numbers (or cell references) and mathematical operators. 
 

Formulas are equations that perform calculations on values. A formula starts 
with an equal sign  
(=). It contains at least two operands and at least one operation. 
 

 Begin EVERY formula with an equal sign (=). 
 After entering a formula, press ENTER to display the formula result. 

 

Select the cell in which the formula result has to be displayed in. Formula 

can be constructed directly into that cell or in the formula bar. Close bracket 

is not mandatory for single Formula and it’s Mandatory for Nested Formulas. 

 

Excel will calculate based on BODMAS RULE (Brackets, Order/Index (or 
Power), Division, Multiplication, Addition & Subtraction) 

 

Example: If you type 2+3*4 in Excel end result will be 14 (Based on BODMAS 
RULE). To add 2&3 first and then multiply with 4, Use Brackets (2+3)*4 
and follow BODMAS RULE result will be 20. 
 

Operand in a formula can be functions, references or constants. Operators 
may be any arithmetic or logical operator 

 

3 Ways of constructing formulas 

 

 If you know the range, directly type the range in the cell. (=C2+D2) 
 If you don’t know the range, Select the range by using mouse.
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 You can also use Arrow Keys to select the range. (In certain places you 
cannot use mouse to select the previous cell because the existing cell content will overwrite 
the previous cell. In such cases only arrow keys can be used to select the range) 



AutoFill the Formulas

 

AutoFill helps you fill in formulae quickly once you have constructed one in 

a cell. In order to AutoFill, select the cell with the formula. Using fill handle 

simply drag your formula down the column (or across the row). AutoFill 

will change the cell references accordingly. (E.g.: If the formula in A3 is 

=A1+A2, when you drag that formula over to B3 then the formula becomes 

=B1+B2.). 
 
Note: The cell references can also change automatically when you copy and paste a formula 
 
 

AutoComplete the Formulas 
 

AutoComplete Option displays the list of formulas when you start to type a 

formula. To select the formulas from the AutoComplete List press TAB Key 

or Use down Arrow Key to select the next formula from the AutoComplete 

List. 
 

Array Formulae 
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In a normal scenario we would individually calculate the amount for each 
product and add them to get the answer. However, to make things simpler 
we may also use Array Formulae. 
 

=SUM (B3:B7*C3:C7) 

 

and Press CTRL + SHIFT + ENTER to fill the array Formula 
{=SUM(B3:B7*C3:C7)} in the selected cell. 
 
Note: Curly Brackets ({}) around the formula indicates that it is applied to an array. 
 
 

FUNCTIONS 
 

Functions are prewritten formulas. Functions differ from regular formulas 

in that you supply the value but not the operators, such as +, -, *, or /. For 

example, you can use the SUM function to add. When using a function, 

remember the following: 
 

 Use an equal sign to begin a formula. 
 Specify the function name. 


 Enclose arguments within parentheses. Arguments are values on 

which you want to perform the calculation. Arguments can be either 
numbers or cell reference having values to be added. 
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 Use a comma to separate arguments.
 

The syntax of a function is as follows 
=Function_name(argument1,argument2,….)  

Example:  
=SUM (A10, B5: B10, 50, 37)  
You don’t need to memorize all the functions available and the arguments 
necessary for each function. Instead, you can use Sigma sign (Σ) which is used 
for sum or click on the drop down for some more function like Max, Min, etc. 
Excel prompts you for required and optional arguments. 

 
Shortcut: You can use "Alt + =" key combination to get the sum function on your 
worksheet. 

 

AutoComplete List 

 

After you type the first letter of a function name, the AutoComplete list 
appears. There are two ways to pick functions from the AutoComplete 
List: 

 

 Double –Click to pick the function from the list. 


 Use Arrow keys to select the function and then use tab key to pick 
the function from the list. 

 

Once you pick the function from the AutoComplete List. Excel will 
complete the function name and enter the first parenthesis. 
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FUNCTION DESCRIPTION SYNTAX EXAMPLE 

Sum 
To find the total of the selected 
range =SUM(RANGE)  =SUM(A1:D13) 

Average  To find the Average 

  
=AVERAGE(Range)  
  =AVERAGE(A1:A10) 

 Max 

  

To  find  the  Maximum, 

Highest & Larger Value 
 

  

=MAX(Range)  =MAX(A2:E100) 
   
 

 =MAX(A1:A10) 

 Min 

  

To  find  the  Minimum, 

Smallest & Lower Value 
 

 =MIN(Range)  MIN(A2:E100) 

count 

  
Counts the number of 
cells that contain 
numbers & Counts within 
specified Range  

 

 =COUNT(Range) 
 =COUNT(A1:A20) 

 

 CountA 

  

Counts the number of 
cells that are not empty in 
a range/ Counts both text 
& Numbers.   

 

 =COUNTA(Range)  =COUNTA(A1:A20) 

 CountBlank 

  

Counts empty cells in a 
specified range of cells.  

 

 =CountBlank(Range)  =CountBlank(A1:A20) 

 

IF Function 

 

IF Function will check the logical condition and displays result, if the condition 
is true, it display true result or it display false result. 
 

You can use the IF function to evaluate a condition. The IF function returns 
different values depending on whether the condition is true or false. 
The syntax for the IF function is: 
 
If(logical_test, [Value_if_true], [Value_if_false]) 
 

The first argument is the condition that you want the function to evaluate. The 
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second argument is the value to be returned if the condition is true and the 

third argument is the value to be returned if the condition is false. Second and 

third parameters are optional. 
 
Example: 
 
=IF(D3>1250,"Good","Bad") 
 
If the condition is TRUE, would return "Good" 
 
If the condition is FALSE, would return “Bad” 

 

 

 

 

 

 

 

 

 

 

 

 

 

NESTED IF 
 

A Nested IF function is when a second IF function is placed inside the first 
in order to test additional conditions. 
 
The syntax for the Nested IF function is: 
 
If(logical_test, [Value_if_true], If(logical_test, [Value_if_true], 
[Value_if_false])) 
 
Examples: 
 
Suppose you want to assign letter grades to numbers referenced by the 
name Average Score. See the following table.  
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You can use the following nested IF function: 
 
=IF(J2<=45,"D",IF(J2<=60,"C",IF(J2<=75,"B","A"))) 
 
 
 
 

 
 

Tips: You can nest up to sixty four levels of If functions in a single formula. 
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IF with AND 
 

AND is a logical function in excel which returns the combined truth value of 
two arguments or conditions. It returns false only when all the conditions 
listed are false. 
 
Syntax: 
 

AND(logical1, logical2...) 

If there is a scenario where we have two conditions whose combined truth 
value would decide the output of an IF function, we can use AND with IF. 
 
Syntax using AND with If 
 
If(and(Condition1, condition2….), True, False) 
 
Example: 
 

Criteria for target customers: Male, have children, and younger than 45 years 
of age 
 
We would use the following formula. 
 
=IF(AND(D4="M",F4="Yes",E4<45),"Target","NotTarget") 
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IF with OR 
 

OR is a logical function in excel which returns False if any one of the 
arguments returns false. 
 
Syntax 
 
OR(logical1, logical2...) 
 

If there is a scenario where we have two conditions of which any one of the 
conditions is false, the if should return the value in the false argument, we 
may use OR with IF. 
 
Syntax using OR with If 
 
If(OR(Condition1, condition2….), True, False) 

 

Example: 
 
Criteria for target customers: should live in either TN or AP 
 
We would use the following formula. 
 
=IF(OR(C17="TN",C17="AP"),"Target","NotTarget") 
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IF with NOT 

 

Not is a logical function used to negate an argument. 
 
Syntax 
 
NOT(logical) 
 

If we have a condition which when not satisfied we need to apply the 
formula, we may use NOT with 
 
IF Syntax using NOT with If 
 

If(NOT(Condition), True, False) 
 
Example: 
 

Criteria for Quarterly Bonus is given to  
everyone except people not met goal. 
 
We would use the following formula. 
 
=IF(NOT(H5="Not Met"),H5*$I$2,0) 
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COUNT IF 
 
Excel COUNTIF formula/function can only check to see if specified cells meet 

one condition. The CountIf function is a specialized form of an array formula 

which is great when you have a single criteria. It does not work well when you 

have multiple criteria. 
 

COUNTIF Syntax   

=countif(range,criteria)   
     

COUNTIF  Counts the number of cells within a  =COUNTIF(Range,Criteria) 
  range that meet the specified criteria.  =COUNTIF(B1:B10,”Male”) 

Example:   

 

=COUNTIF(A1:A20,">20") Which would COUNT all numeric cells in the 
range A1:A20 where values were greater than 20. 

 

Note the criteria argument is in the form of a number, expression, or text 

that defines which cells will be counted. For example, criteria can be 

expressed as 20, "20", "=20", ">20", "East", "E*" 
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TEXT Functions 

 

Function 
Descriptio
n    Syntax Example Result 

     

UPPER 
Converts the text to 
all =UPPER (text) =UPPER(A1) ACTIVE EDU 

 
upperca
se.        

     

LOWER 
Converts the text to 
all =LOWER (text) =LOWER(A1) active edu 

 
lowerca
se.        

       

PROPER 
Convert
s 

the  
text to =PROPER (text) =PROPER(A1) 

Active Edu 

 

 
Proper 
Case (the first    

 
letter in each word 
is    

 
capitalize
d)       

LEN 
Returns 
the 

number 
of =LEN (text) =LEN(A1) 10 

 
charact
ers  in  the    

 
arguments/c
ell      

TRIM 
Removes all leading 
and =TRIM (text) =TRIM(A2) Technologies 

 trailing 
spac

es and    

 
replaces internal 
strings    

 
of multiple spaces 
by a    

 
single 
space       

CLEAN 
Removes all 
nonprinting =CLEAN (text) =CLEAN(A1)  

 
characters from a 
string.    

 These  
“garbage

”    

 
characters often 
appear    

 
when you import 
certain    

 
types of 
data.       
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CONCATENAT
E 

To  join  two or  
more 

=CONCATENATE(tex
t1, 

=CONCATENATE(A1
,A2) 

Active 
EduTechnolo
gies 

 
words  
or text 

string
s text2)   

 
together without 
space.    

CONCATENAT
E 

To  join  two or  
more 

=CONCATENATE(tex
t1, 

=CONCATENATE(A1
,” 

Active Edu 
Technologies 

 
words  
or text 

string
s “ “,text2) “,A2)  

 
together with 
space.     

& 
Does 
some 

activi
ty of =text1&text2 =A1&A2 

ACTIVE 

EDUTechnologi

es 

 

 
concatenate 
function     

 
(without 
space)      

LEFT Returns 
th
e leftmost 

=LEFT(text,[num_ch
ar]) =LEFT(A1,5)  Activ  

 
charact
ers from a text      

 value        

RIGHT 
Returns  
the 

rightmos
t 

=RIGHT(text,[num_c
har] =RIGHT(A1,7)  Ive Edu  

 
charact
ers from a text )     

 value        

MID Extracts a 
substrin

g =MID(text, =MID(A1,2,4)  ctiv  

 
from a string 
(starting at start_position,     

 
any 
position)  [num_char])     

        
Cell A1 has text “Active 
Edu”       
Cell A2 has text 
“Technologies”        
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Date-Related Functions 

 

END DATE – START DATE -To find the number of days between two dates 
 

Function Description Syntax Example   
    

DATE Returns   the   serial = DATE (year, month, =DATE(2008,9,13) 
 number of a particular day) returns 39704, serial 
 date  number represents 
   13/09/2013  

DAY Returns the day from a =DAY(DATE CELL) =DAY(A1)  

 date  Returns 3 for the date 
   03/09/1989  

MONTH Returns the month from =MONTH(DATE CELL) =MONTH(A1)  

 a date  Returns 9 for the date 
   03/09/1989  

YEAR Returns the year from a =YEAR(DATE CELL) =YEAR(A1)  

 date  Returns 1989 for  the 
   date 03/09/1989 
 

 

DATEDIF: Calculates the number of days, months, or years between two 
dates. 

 
=DATEDIF (Start_Date, End_Date, Unit_Code) 

 
Unit_Code Returns Example 

   

“Y” The number of complete years in the period. =DATEDIF(A1,A2,”Y”) 
“M” The number of complete months in the =DATEDIF(A1,A2,”M”) 

 period.  

“D” The number of days in the period. =DATEDIF(A1,A2,”D”) 
“MD” Remaining days after completed months =DATEDIF(A1,A2,”MD”) 

   

“YM” Remaining months after completed years =DATEDIF(A1,A2,”YM”) 
   

“YD” The  difference  between  the  days  of =DATEDIF(A1,A2,”YD”) 
 start_date and end_date. The years of the  

 dates are ignored.  

   

 

 



Microsoft Excel –Advance level      

Active Edu - Technologies India Pvt. Ltd. 
3AB, 3

rd
 floor, Chandra towers, S.A Road, Vyttila ,Cochin, Kerala, India- 682019 

Ph: 0484-4033399 Email: excel@activeclass.in ,Facebook: https://www.facebook.com/activeedutec 

website: www.activedu.in, www.activeexcel.com 

 

 

 

 

Chapter 6: VLOOKUP 

 

V‐lookup is a function that searches for a value (lookup value) in the 

leftmost column of a given database (table array) and returns a 

value in the same row from a column you specify.  
Vlookup is used to Match data & Retrieve the result. A lookup formula 

essentially returns a value from a table by looking up another related value. 

 

Syntax: 

 

VLOOKUP (lookup_value,table_array,col_index_num,range_lookup) 

 

The VLOOKUP function’s arguments are as follows: 

 

 Lookup value is the value to be found in the first column of the table. 
It is the value that you are looking for. Lookup_value can be a value, a 
reference or a text string. 


 Table array is the table of information in which data is looked up. It 

is the source database. Use a reference to a range or a range name. 


 Col_index_num is the column number in table_array from which the 
matching value must be returned. 


 Range lookup is a logical value that specifies whether you want 

VLOOKUP to find an exact match or an approximate match. If Range 

Lookup is set as FALSE or 0, VLOOKUP will find an exact match. If 

exact match is not found, the error value #N/A is returned. If it is set 

to TRUE or non‐zero, it finds the nearest value that is less than 

lookup value. 
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In the above figure lookup value is in Column D; table array G3:H12; Column 
index number is 2. 
 

Example: =VLOOKUP(D3,G3:H12,2, FALSE) 
 

The lookup table resides in a range that consists of three columns (G3:H12). 

Because the column index number for the VLOOKUP function is 2, the formula 

returns the corresponding value in the second column of the lookup table. Note 

that an exact match is required. 

Excel’s data validation feature enables you to set up certain rules that 
dictate what can be entered into a cell. Restrict the cells to accept only 
certain value based on condition. 

 

Data Validation is a process which restricts the users from entering 

invalid data for individual cells or cell ranges. It limits the data 

entry to a particular type, such as whole numbers, decimal 

numbers or text and sets limit on valid entries. 

 

For example, you may want to limit data entry in a particular cell to whole 
numbers between 1 and 12. If the user makes an invalid entry, you can 
display a custom message. 
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Chapter7: Data validation 

 
SETTING DATA VALIDATION 
 

 Select the Cells to which Data validation to be applied 


 Click Data Tab >> Data Tools Group >> Click Data Validation >> 
Data Validation Dialog Box is Opened 


 On the Settings tab, Data Validation dialog box enables you to specify 

a wide variety of data validation criteria. From the Allow list, select 

a data validation option. 
 Any Value: Selecting this option removes any existing data 

validation. 


 Whole Number: The user must enter a whole number. For 
example, whole number greater than or equal to 100. 


 Decimal: The user must enter a number. For example, greater 

than or equal to 0 and less than or equal to 1. 
 List: The user must choose from a list of entries you provide. 


 Date: The user must enter a valid date. For example, greater 

than or equal to January 1, 2007, and less than or equal to 
December 31, 2007. 

 Time: The user must enter a valid time. For example, greater 
than 12:00 p.m. 


 Text Length: The length of the data (number of characters) is 

limited. For example, length of the entered data be 1 (a single 
alphanumeric character). 


 Custom: You must supply a logical formula that determines 

the validity of the user’s entry (a logical formula returns either 

True or False). You can enter the formula directly into the 

Formula control or you can specify a cell reference that 

contains a formula. 
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 From the Data list, select the operator you want. Then 
complete the remaining entries 


 Enter the Input Message if required in Input Message tab. 

Enter the error message if required in Error Alert tab. Click OK 

to set the validation rule and close the dialog box. 

USAGE OF DATA VALIDATION 

 

Creating a List 
 

A list is an effective form of data validation where the user is 
allowed to select an option from a drop‐ down list which is built‐ in 
to the cell. The data source may be written manually by the user 
or selected from the same sheet. 
Select a blank cell >> Select Data Tab >> Select Data Validation 

from Data Tool group >> Select List from the Allow Drop-Down>> In 

Source, select the cell with values, or type the data with comma. 

If the source is from a different sheet, create a named range for 
all the values and use the name in the Source field for Data 
Validation. 
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Allow Numbes within Limits 
 

In the Allow box, click Whole Number or Decimal. >> In the Data 

box, select the type of restriction you want. For example, to set 

upper and lower limits, select Between. >> Enter the minimum, 

maximum, or specific value to allow. 
 

 
 
Allow Dates or Times within a Timeframe 
 
In the Allow box, select Date or Time. >> In the Data box, select the type of 

restriction you want. For example, to allow dates after a certain day, select 

greater than. >> Enter the start, end, or specific date or time to allow. 

 
Allow Text of a Specified Length 
 
In the Allow box, click Text Length. >> In the Data box, click the type of 

restriction you want. For example, to allow up to a certain number of 

characters, click less than or equal to. >> Enter the minimum, maximum, or 

specific length for the text. 
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Chapter 8: Security & Protection 
 

To prevent a user from accidentally or deliberately changing, 

moving, or deleting important data from a worksheet or 

workbook, you can protect certain worksheet or workbook 

elements, with or without a password. You can remove the 

protection from a worksheet as needed. 
 

 Protecting worksheet elements 
 Using a password to control access to protected elements 
 Protecting the structure and windows of a workbook 





Protecting Worksheet 
 

 Home Tab >> Under Cells Group >> Click Down arrow below 

Format Button >> Click Protect Sheet from the Drop-Down >> 

Protect Sheet Dialog Box Display >> Type Password & Click 

Ok. 


 Review Tab >> Under Changes Group >> Click Protect 
Worksheet >> Protect Sheet Dialog Box Display >> Type 
Password & Click Ok. 
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Protecting Part of a Worksheet  
 

When you protect an entire worksheet, all the cells in the worksheet 

are locked by default. This means that users cannot make changes 

to any cell in the worksheet. To allow the users to make changes to 

particular cells only, you must unlock the cells manually before 

protecting the worksheet.  

 

This will allow the users to change data only in the unlocked cells. 

You can hide the formula before protecting the sheet, so that it is 

not visible to the user after sheet level protection is activated. 

To password protect only part of a worksheet perform the following 

steps. 

 

STEP 1: Select the range of cells to be accessible >> Right Click & 
Select Format Cell >> Format Cells Dialog Box is Opened >> 
Activate Protection Tab >> UnCheck  
―Locked‖ >> Click OK 

 

Follow Step 2 only if you wish to hide your formulae or proceed to 

step 3. 
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STEP 2: Select the range of cells with formulae to hide from users >> 
Right‐ click and Select Format Cells >> Format Cells Dialog Box is 
Opened >> Activate Protection Tab  
>> Check ―Hidden‖ check box along with ―locked‖ >> Click OK 

 

Follow step 3 to password protect the worksheet. 

 

STEP 3: Click Review Tab >> In the Changes ribbon group, click 
Protect Sheet to open the Protect Sheet dialog box >> Type a 
password and click OK. 
 
 

 

 

 

 

Protecting a Workbook 

 

Workbook level protection can be done in two ways: 

 
 Workbook structure (prevent changes like worksheets being moved, 

deleted, inserted, hidden, unhidden, or renamed)  
 
 Workbook window (ensure that a workbook’s window is the same 

size and position each time it is opened.)  
 
To protect a workbook, 

 
Click Review Tab >> In the Changes ribbon group, click Protect Workbook >> 

Protect Workbook dialog box appears >> Select either or both the options 

(Structure or Windows) >> To prevent others from removing workbook 

protection, you can set a password >> Click OK. 
 

Password Protecting a File 
 
File can also be password such that any user would be asked for 
a password before he is able to view or modify your file. 
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To do this, follow the steps below, 

 
Click on office‐ button > Save as >> In the save as dialog box, 
click on tools > General options >> Set the password to open or 
modify as the case may be >> Save the file. 
 
Now the file is password protected 
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Chapter 9: Sorting & Filtering in Excel 

 
 
 

DATA SORT 

Sorting rearranges the rows based on the contents of a particular column. 
 

Note: If your spreadsheet contains formulas, be careful when using the sort 

feature. Formulas rely on cell references to perform their calculations and 

moving the data with the sort feature may destroy these references. 
 

To sort a list of data: 
 

 Select a single cell in the column containing the data you want to sort. 


 Select the Home tab, Under the Editing group, press the Sort and 
Filtering button and select the order you want your data to be 
sorted. 



Note: If you select an entire column, Excel will sort only that column 
and will mismatch the data contained in the other columns. 

 

Single Level Sorting 

 
Sorting done with respect to the contents of one column 
 

 Select any cell in the column by which you want to sort >> Activate the 

Data Tab >> In the Sort & Filter group, click the Sort Ascending or Sort 

Descending button >> This will sort the entire database.  
 

Multi-Level Sorting 
Sorting done with respect to the contents of multiple columns. Data sort can 
be done with any number of columns. 
STEP 1: Open Sort Dialog Box 
 
Sort Dialog Box can open by three ways: 
 
Sort Dialog Box can open by three ways: 
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 Choose Data Tab >> In the Sort & Filter Group, >> Click Sort Button >> 

Sort dialog box is opened.  
 

 Choose Home Tab ➪ Editing 

➪ Sort & Filter ➪ Custom 

Sort. 


 Right-click any cell in the 

table and choose Sort ➪ 

Custom Sort from 


the shortcut menu. In the 

Sort Dialog box, click the 

Add Level button to insert 

any number of 
 

 
 
 

 
 

STEP 2: Add Levels to Sorting 
 

 From the Sort by list, select the column heading of the column by 
which you want to sort the list, and then select a sorting order. All 
records will be sorted first based on the column and the sorting 
order you selected. 


 Then click “Add Level” and select the next column by which you want 

to sort. If necessary, add more "Then by" fields by clicking "Add 
Level." 

 When all "Then by" fields are complete, click OK. 




Customized Sorting 
 

When we sort the data, region wise, it sorts either in the ascending or 

descending order. However, if you want to sort your data in a 



Microsoft Excel –Advance level      

Active Edu - Technologies India Pvt. Ltd. 
3AB, 3

rd
 floor, Chandra towers, S.A Road, Vyttila ,Cochin, Kerala, India- 682019 

Ph: 0484-4033399 Email: excel@activeclass.in ,Facebook: https://www.facebook.com/activeedutec 

website: www.activedu.in, www.activeexcel.com 

customized order, for Example East, West North, and South, we 

would need to perform a custom sort.  

 Select any cell in the list >> Data Tab >> In Sort & Filter Group, 

click sort >> Sort Dialog Box is opened >> From the Sort By list, 

select the column heading of the column by which you want to 

sort the list >> Select Custom List under order drop down 

Menu >> Custom List Dialog Box gets opened >> Type the 

sequence by which you wish to sort >> Click Add 

  
DATA FILTER 
 

Filtering a table refers to displaying only the rows that meet certain 

conditions (The other rows are hidden). Unlike sorting, filtering doesn't 

just reorder the list. It actually hides the rows or columns containing data 

that do not meet the filter criteria you define. Excel has an AutoFilter 

feature that makes it very easy to extract data. 
 

To use the AutoFilter: 
 

 Click on any cell in your spreadsheet. 


 Select the Home tab, Under the Editing group, press the Sort and 
Filtering button and select the Filter button. 
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 Drop-down menus will appear next to each cell heading. Clicking on 
any drop-down menu will provide you with options for sorting or 
filtering. 

 
For example: 
 

If you want only Chennai & Bangalore Region to be displayed under Area 
Column, Place the check mark next to Chennai & Bangalore alone, click OK. 
 
You can filter a table using any number of columns. 
 
For example, you may want to see only the Chennai listings in which the 
“Type” is Single Family. Just repeat the operation using the “Type” column. 
Tables will display only the rows in which the “Area” is Chennai and the 
“Type” is Single Family.  
 

Number, Text or Date Filters 
 
 

Once you add filter to data, you also get a Number, Text or Date 

Filter Option in each fields depending on the type of data in that 

column. These can be used for field specific filtering like ―Begins 

with‖, ―Contains‖ for text fields, ―Greater than‖, ―Lesser than‖, 

―Between‖ for number fields or ―Before‖, ―After‖ for date fields. 
 

From the drop-down list of the column for which you want to 

create criteria, choose Text Filters, Date Filters or Number Filters, 

click on Custom to display the Custom AutoFilter dialog box. 
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Number Filter 

 

 

 

 
 

        Data Filter    Text Filter 
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Advanced Filter 
 
While using Advanced Filter, we need to have a criteria range and a list range. 

List range is your database. To create a criteria range, we need to make a 

copy of the column header of the database. 
 

 

 

 
 

 

 Data Tab >> In Sort & Filter Group >> Click Advanced >> Advanced 
Filter Dialog box is displayed  

 
 In the List Range box, select the cell range you want to filter. The cell 

range must include the associated column headings.   
 In the Criteria Range box, select the cell range that contains your criteria.  
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Chapter: 10 Pivot Table 
 

Excel pivot tables are very useful and powerful feature of MS Excel. They 

can be used to summarize, analyze, explore and present your data. Pivot 

Tables are interactive tables that allow the user to group and summarize 

large amounts of data in a concise, tabular format for easier reporting and 

analysis. 
 

A Pivot Table is an interactive worksheet based table that quickly 

summarizes large amounts of data using the format and calculation 

methods you choose. It is called a Pivot Table because you can rotate its 

row and column headings around the core data area to give you different 

views of the source data. As source data changes, you can update a pivot 

table. It resides on a worksheet thus; you can integrate a Pivot Table into a 

larger worksheet model using standard formulas. 
 
Grouping and summarizing large amount of data into a simple report 
 
First identify the common field column and draw sample report & create the 
pivot. 
 
Group the data to create monthly, quarterly and yearly reports. Shortcut for 
date grouping (F12) 
 

Steps to create pivot table 

 

 To insert a new pivot table in to your spreadsheet, go to Insert ribbon 
and click pivot table icon and select pivot table option.  

 
 Excel will display a pivot table wizard where you can specify the table 

range & choose the target location where pivot table has to be placed. 

Select “New worksheet” option and your pivot table will be placed in 

newly created worksheet or select “Existing Worksheet” with location to 

place pivot table in the current worksheet.  
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The pivot report UI is very intuitive and sandbox like. To make powerful 
analysis, all you have to do is drag and drop fields in to the pivot table 
grid area. The pivot report is divided in to header and body sections. You 
can drag and drop the fields you want in each area. 
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Examining PivotTables 
 
 

The data on which a PivotTable is based is called the Source Data. Each column 

represents a field or category of information, which you can assign to different 

parts of the PivotTable to determine how the data is arranged. We can add 

four types of fields Report Filter, Row Labels, Column Labels & Σ Values. 
 

 Pivot Table is created as shown below. 
 



 
 

 

 
 

Using “Group” feature of Excel, you can easily create monthly or quarterly 

reports from daily data. Right Click Pivot Table and Untick Subtotal, subtotal 

will not be displayed in the pivot table. Report Filter is used to simplify the 

Pivot further. 
 

 

 

Create a Graph using Pivot Data 
 

You can use a PivotChart to graphically display data from a PivotTable. A single 

PivotChart provides different views of the same data .When you create a 

PivotChart, the row fields of the PivotTable become the categories, and the 

column fields become the series. 
 
 
To create a PivotChart, 
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 Select any cell within a PivotTable >> Click Chart in the Tools group on 

the Options tab >> Select options for the chart >> click OK.  
 
You can also create a new PivotChart and PivotTable at the same time by 

selecting a cell in the source data, and selecting PivotChart from the PivotTable 

list in the Tables group on the Insert tab. 
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Chapter:11  Conditional Formatting 
 

 
Conditional formatting enables you to apply cell formatting selectively and 
automatically, based on the contents of the cells. 
 

Conditional formatting allows you to change font style, underline, and 

color. Using conditional formatting, you can also apply strike-through as 

well as borders and shading to the cells. However, you cannot change the 

font or the font size of the contents in the cell. 
 
For example, you can set cell background color as Red for Negative values & 
Green for Positive values. 
To apply a conditional formatting 
 

 Click the cell you want to format. 
 Click Home Tab >> Styles >> Conditional Formatting 
 Then use any of the choices below as per your need, 


 Highlight Cell Rules: Rules include highlighting cells that are greater 
than a particular value, between two values, contain specific text 
string, or are duplicated. 



 Top Bottom Rules: Rules include highlighting the top 10 items, the 
items in the bottom 20 percent, and items that are above average. 



 Data Bars: Applies graphic bars directly in the cells, proportional to the 
cell’s value. 



 Color Scales: Applies background color, proportional to the cell’s value. 


 Icon Sets: Displays icons directly in the cells. The icons depend on the 
cell’s value. 



 New Rule: Enables you to specify other conditional formatting rules, 
including rules based on a logical formula. 



 Clear Rules: Deletes all the conditional formatting rules from the 
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selected cells. 


 Manage Rules: Displays the Conditional Formatting Rules Manager 
dialog box, in which you create new conditional formatting rules, edit 
rules, or delete rules. 
 

 
For Example: Value greater than equal to 50 should have cell colour as green, 
then choose  
Highlight Cell Rules and click More Rules. New Formatting Rule dialog 

Box is opened. Choose greater than or equal to from the drop down. Then 

Click Format button Format Cells dialog box opens. In the Fill tab select 

the background colour as Green and Click OK. 
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 Chapter 12:   Page setup & Print  
 
 

When you want a hard copy of worksheet data, Excel gives you many tools for 

choosing how that printout will look. Swapping the page orientation between 

portrait and landscape, scaling the size of the printout and choosing whether 

to print worksheet gridlines are but a few of the options that can be set. Excel 

automatically assigns headers and footers to your worksheet data, but you can 

change or enhance these very easily. 
 

Print Preview 

Before sending anything to print, it is always a good idea to preview what you 
will see on the page. Print Preview shows you what the worksheet will look like 
when it is printed. 
 
To access Print Preview: Select Office Button >> Print >> Print Preview 
 

Page Setup 

When you want to alter headers and footers, orientation and so on, you use 

the Page Setup dialog box. You can open Page Setup dialog box by clicking 

dialog box launcher from the Page Setup Group, under Page Layout Tab. There 

are four tabs within this dialog; each gives one aspect of your printout. 

 

 PAGE TAB   
o Orientation: Use this setting to swap between portrait and landscape 

printouts.   
o Scaling: The size of your printout can be increased or decreased 

manually.   
o Paper Size: Size of the paper in which you wish to print the 

content can be selected.  
 

 Margin Tab: The Margins tab lets you set top, bottom, left and right 
margins and center your data horizontally and vertically on the page.   

 Header & Footer Tab: use this setting to include the Header/Footer in 
your print out. You can also add Picture instead of text to header & 
footer.   
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 SHEET TAB: Use this tab to set a print area   
o Print Area- Use this to set the range of cells that you want to print. If 

you do not   
set a Print Area, Excel will print all the data on the active worksheet.  

o Print Titles: Rows to Repeat at Top, Columns to Repeat at Left. 

When your printouts run to several pages you may have column 

and row headings that you would like to print on each new page. 

Excel allows you to specify any number of rows and columns to 

repeat when you have a multi‐page printout.  
 

Print – Collate 
 
By default, Excel will print one copy of the item you have sent to print. You can 

print multiple copies by changing the Print dialog settings. When you print 

multiple copies of a document, Excel lets you choose whether the copies are 

collated (Excel prints each whole document before it starts on the next copy) 

or uncollated (Excel prints however many copies you have requested of each 

page). 
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Chapter 13:  Macros

 
You can use macros to automate complex and repetitive tasks. A Macro is a 
series of instructions that execute automatically with a single command. 
 
For example, you can create a macro to format a worksheet or to print a 

report. You can use the macros already available in Excel or create your own 

from the Developer Tab. To activate the Developer Tab, Click on Office Button, 

Excel Option and enable "Show Developer Tab in Ribbon". 
 
A macro is a set of instructions that tells Excel what to do. Macro is a saved 

sequence of commands that can be stored and then recalled with a single 

command or keyboard stroke. Macro does what Excel cannot do. 
 
For example: Function to find the reverse of number 
 

 
 
 

Recording a Macro 

 
Just as a Tape Recorder can be used to record sounds which can 
be played back later, so the Macro Recorder can record your 
actions into a Macro. 
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These Macros can be run whenever you wish, automatically 
repeating your recorded actions and so saving your time and 
effort. 
 

 Recording a Macro which uses Absolute Cell References 


 Recording a Macro which uses Relative Cell References 

 
 
 
 
 

To record a macro: 
 

 Click Macro Recording in the status bar to open the Record Macro dialog 
box.  

 
 Specify a name for the macro and a shortcut key. Macro names must 

begin with a letter and cannot contain spaces. They can include letters, 

numbers, and underscores.   
 Click OK to start recording the macro.  

 
 Perform the actions you want to include in the macro. As you work, 
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Excel records the sequence of steps.  
 

When you’re finished, click the Stop Recording button on the status bar. 
 

 This Workbook – Records a macro in the current workbook  
 

 New Workbook – Records a macro in the new workbook. Macros 
recorded in this workbook are available when new workbook is open.  

 
 Personal Macro Workbook – Macros are recorded in personal.xlsm. The 

personal macro workbook is available when you start excel.  
 

 
Running a Macro Using Menu Commands 
 
To run a macro, click the Play Macro button in the status bar to open the 

Macro dialog box, as shown in diagram. Select the macro of your choice, and 

click the Run button 
 
 

 
 

Macros that are contained on all currently open workbooks are displayed in 
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the list. To run a macro, select macro from the list and click Run. The Macro 

dialog box provides several additional capabilities: 
 
Step: Click this button to run the macro step by step. Stepping through a 
macro is useful for debugging purposes 
 
Edit: The module containing the macro is activated, and the macro is displayed 
in the visual basic editor for editing purposes. 
 
Delete: Deletes the selected macro. (You can also delete macros by activating 
the module and clearing the macro.) 
 
Options: Lets you assign a shortcut key, add a command to Excel's Tools menu 
that runs the macro, and change the description of the macro. 

 
 
 
Viewing the recorded Macro 
 
As mentioned in the table above, from the macro dialog box, we can edit or 

step into a macro's code. Clicking on either of these options opens the visual 

basic editor. The visual basic editor layout is shown in figure. 
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The above image shows the editor when book1 is open. If you have macros in 

this workbook, you would see an additional folder in the project explorer 

called "Modules". All macros in a file are stored in Modules. These modules are 

by default named as Module1, Module2 etc. 
 


